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Overview

In modern businesses, the volume of information being managed by an organization is
increasing whilst at the same time this information is becoming ever more critical to a
businesses success.

If this information is not managed and controlled, there is the potential for companies
to make vital decisions based on incorrect data or become over whelmed by the scale
of the information.

Master Data Management (MDM) solutions can provide a single, trusted view of
critical business data and help organizations meet growth, revenue-generation and
cost-reduction goals.

The MDM Server provides such a solution with a comprehensive range of out of the
box services that help businesses manage and control their information.

The MDM Workbench allows these services to be enhanced or extended to tailor the
capabilities for a specific deployment.

This tutorial shows how the MDM Workbench can be used to design a model of these
additional capabilities and how these can be deployed to the MDM Server.

No prior experience of either the MDM Server or MDM Workbench is assumed

The instructions in this tutorial are broken down into two types of information. Those
sections marked with a 'textpad' icon contain background information that you can
choose to skip if if time is pressing and refer to later:

DOGH0000

(BAGKGROUND[) = 1

Those sections marked with a 'user' icon contain the key steps that must be followed
to complete the tutorial:

(KEY STEPS!) @
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Machine Requirements
The requirements for running MDM V11 are as follows:

*  8GB-12GB of memory
* 50GB of dedicated disk space required for a typical installation

To set-up a machine for this tutorial, if MDM is not already installed, then it is
recommended to run a 'Typical Installation'. Instructions for this can be found by
following the link below:

https://www.ibm.com/developerworks/community/blogs/64033fdd-4a35-4733-8521-
a39abcdf4fb3/entry/installing_mdm_workbench_v11?lang=en

System Configuration

This tutorial assumes you have completed a typical installation of MDM V11
including the software listed below:

* IBM Rational Application Developer for WebSphere Software Version 8.5.1
* IBM WebSphere Application Server Version 8.5.0.2

* IBM InfoSphere Master Data Management Workbench Version 11

* InfoSphere MDM Standard Edition or Advanced Edition Version 11
 IBM DB2 Version 10.1

For a typical installation the default user ids and passwords are as follows:

* DB2 User ID: db2admin

* DB2 Password: db3Admin

*  WebSphere User ID: mdmadmin
*  WebSphere Password: mdmadmin
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DO00000(

’ 1 Changes in Version 11 (BACKGROUND!)

What’s this section about? Discusses some changes since the last version of the
workbench. If you have not used the workbench before you can skip this section.

One of the most apparent changes when using the latest version of the workbench is
that you no longer need to use the DEST utility to prepare the development
environment. Unlike previous releases where an MDM Enterprise Archive (EAR) was
unpacked into the workspace, version 11 uses an Enterprise Bundle Archive (EBA)
stored outside the workspace to provide the basis for development. The necessary
dependencies on the EBA are established automatically when the workbench is
installed. Modules developed in the workspace are combined into a Composite
Bundle Archive (CBA) which can be deployed alongside the main server EBA to
customize MDM.

OO0

[ ~t Some up-front Terminology (BACKGROUNDY)

What’s this section about? Provides an introduction to some of the core components
that make up a solution. Skip this section if required and refer to it as necessary.

Entity Type — A physical entity in the MDM data model. As supplied the MDM
Server supports a range of different Entity Types such as Person, Contract or Group.
Additional Entity Types may be created in the Workbench to extend the data model.

Attribute — A field defined for an Entity Type or Entity Type Extension

Entity Type Extension — An extension to an out of the box Entity Type. Typically
this mechanism is used to add additional attributes required by a solution that are not
present in the out of the box data model. For example, if a Contract needed an
additional contract classification field, an Entity Type Extension could be defined to
add this. This should not be confused with a subtype, which is a separate concept.
Creating an Entity Type Extension of Contract allows additional fields to be added to
requests and responses that include instances of a Contract. The extension however is
not considered to be a separate type in its own right. Additional fields are included in
a generic “‘extended block™ that’s common to all Entity Type definitions.

Code Table — A structure used to contain a set of String values that can be referred to
by a Type Code. Conceptually similar to an enumeration in Java, these structures are
used to hold well defined sets of values that don’t change often. For example, we
could create a Code Table to hold a set of colors (“Red”, “Green”, “Blue”, “Orange”)
Once deployed each Code Table entry has both a “value” — the String representation
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and a “type” — essentially the numerical database key. For example, (1, Red) or (2,
Green)

Type Code — A reference to an entry within a Code Table. When referencing a Code
Table, either the Code Table “Type” or “Value” may be specified. If both are present,
they must match.

Transaction — A service or operation that can be executed by a client on the MDM
Server. For example, when adding a person to the database, users would invoke the
“addPerson” transaction. XML is used to define a request which can be passed to the
server over a number of different interfaces (eg a WebService call)

Behaviour Extension — Allows the default services provided by MDM to customized
by executing code before and/or after the core service runs. For example, we could
add additional validation to ensure that specific constrains are met when performing
an addContract transaction.
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Ei Solution Overview (BACKGROUNDY)

What’s this section about? Provides an outline of the solution that you will build in
this tutorial. If time is pressing, you can skip this and simply follow the instructions in
further sections below. Its recommended that you do at least review the model
diagram in this section.

For this tutorial, we have created a simplified model that consists of a range of
different elements supported by the workbench. The tutorial shows how this model is
defined and converted into code. It demonstrates how this code can be modified to
customize the solution and how this can then be deployed to and tested on a server.

To keep things simple and allow you to focus on the mechanics involved, we
minimized the amount of additional complexity that might be found in a real-world
scenario. During the course of this of this tutorial we will build following model:

wentity_types
[ Site

[Eg name : String

1 |- siteReference

« |- buildings
«entity_types
] Building
._:-Ename:string

- BuildingReference
- rooms

i de_tables
«entity_types «code |
Room -roomType Q RoomType

*
[Eg name : String 1
1 \-RnomReference

* tmachineAssets
| MachineAsset

[Eg name: string «=entity_types=
[ serialNumber : String |~ owner | person
= description : String * 0.1

“;Extends»

sbehavior_extensions «entity_extensions
E MinimumAgeCheck XPerson

Eg heavyMachineryCertified : Boolean

This model reflects a simplified asset tracking system used to manage machinery in a
factory complex.

Site — A new Entity Type introduced to hold information about a factory or plant
location.

Building — A new Entity Type used to hold details about a building at a Site
Room — A new Entity Type used to hold details of a specific Room within a Building

MachineAsset — A new Entity Type used to hold details of a physical machine asset
within a room.
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RoomType — A Code Table used to define the set of possible room classifications
(“Office”, “PlantRoom”, “MeetingRoom”, “StoreRoom”)

XPerson — MDM provides an “of the box™ Entity Type called Person that holds
details of individuals that exist in the database. XPerson is an Entity Type Extension
of Person that defines an extra attribute not present in the standard data model. In this
case, it’s a field that indicates if a person has been certified to operate heavy
machinery.

MinimumAgeCheck - Behaviour extension to ensure that all employees are over 16.

Additional logic will run prior to the “addPerson” transaction to enforce this.

QJ Step 1 - Setting up the Workspace (KEY STEPS!)

What’s this section about? The workspace will be prepared for development. You
must follow these steps to complete the tutorial.

e Start RAD or RSA by running the application from the Desktop or Start
menu

e  When the “Workspace Launcher” dialog appears, select a new folder to
contain the projects developed in this tutorial and click OK

() Workspace Launcher 3w
Select a workspace

Rational® Application Develaper for WebSphere® Software stores your projects in a folder called a workspace.
hoose a workspace folder to use for this session,

Wnrksp<31 C:\myworkspacel ’ - Browse...

[ Use this as the default and do not ask again
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Each time a brand new workspace is opened, the Configuring the WebSphere
Application Server dialog will appear. The next steps show how to use this to create
a connection to the WebSphere server configured on the local machine:

e In the Configuring the WebSphere Application Server dialog, ensure the
“Add WebSphere Application Server V8.5 configuration to the
workspace” option is checked.

e Specify the user id and password, for a typical installation the defaults

are “mdmadmin” and password “mdmadmin” under the authentication
settings and click Finish

@ Configuring the Web5Sphere Application Server = @
Runtime environment and profile settings

There are no profiles associated with these server runtime environments,

Based on your Installation Manager settings, you have the following installations of WebSphere
Application Server VB.5:

Add WebSphere Application Server V8.5 configuration to the workspace >

Package group name: [IBM ‘WebSphere Application Server V8.5 ']
Installation directory: C:\Program Files (xB6\IBM\WebSphere\AppServer

JRE for the runtime environment: [WebSphere Application Server JRE 1.6, 64 bit V] i
Profile name: [AppSnJUl V]
The profile is specify the authentication settings:

mdmadmin

d: ssssssss

@ Einish l I Cancel

e  Once the workspace opens, close the Welcome screen by clicking on the
cross on the Welcome tab.

@ Java EE - Rational® Application Developer for ®

P =) O >
File Edit Mavigate Search Project Run  Window Help

Welcome
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You should now see an empty workspace as shown below:

New “Development Projects”

are created in here and

contain models and code Resources being edited appear
developed in the workspace in the right hand panel

) MDM Dev¢lopment - Rational® Application Developer for WebSphere® Scftware = o=
un  Master Data

File Edit Mevigate Search agement  Window  Help

[ Package Explorer 22 . [ Data Source Explorer

[2. Problems | ] Tasks | I Properties |4k Servers £3 0, = Progress

0 P
4, Web Preview Server
E‘g ‘WebSphere Application Server v8.5 at locdlhost [Stopped]
22 1 items selected
The Problems tab shows details The Servers tab provides control over
of any errors the WebSphere application server

o
“{g Step 2 — Configuring the Server Connection (KEY STEPS!)

What’s this section about? The WebSphere server connection definition will be
updated to control how code is deployed from the workspace to the server

The server connection created by the “Configuring the WebSphere Application
Server” dialog above needs some fine tuning. We need to change the settings so that
binary code developed in the workspace is copied to the WAS server rather than being
linked to it. The distinction may seem subtle, but the effect is to de-couple code
developed in the workspace with the code deployed on the server. The server
deployment will remain valid and functional even if the workspace is deleted (if it
was linked to a workspace that was deleted, this would cause problems). The
following steps show how to do this:

e Open the Servers view from the RSA main menu Window -> Show View ->
Servers
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Hew Winow | H-$-0 Q- A G-E
Mew Editor

'CRMaddcontr [X| ResponseTCRMaddPerso [x
Open Perspective L
Show View v Il Bookmarks

B Console Alt+Shift+Q, C

Customize Perspective ..

Save Perspective As. [ Dats Source Explorer

™y .
Feset Perspective.. #®  Erterprise Explarer o
Ellose Porpesie ‘;* MEsIEEEr
Close &ll Perspectives u=| | Qudine Pllegifitt@ @ —
[Z0 Problems AltsShift+Q, X
MNavigation ‘e PrapaRics
Weh Browser v | A ift+0, $
Preferences
B2 v
Applicat o 1
Update 5
Other... Alt+Shift+Q, Q

e Double click on the WebSphere Application Server v8.5 in Servers view to
open the configuration settings for the server connection.

[£ Markers | =1 Properties | 4k Servers 52 Data Source Explorer | [ Snippets | T Annotations| & Consale

B eb Do il
I WebSphere Application Server v8.5 at localhost [Stopped] I

e Under Publishing settings for WebSphere Application Server, ensure the
Run server with resources on Server option is selected.

*“WebSphere Application Server v8.5 at localhost 7

B Overview
General Information ¥ Publishing
Specify the host name and other common settings.
- } Timeouts
Server name: WebSphere Application Server v.5 at localhost
Host name: localhost ~ Publishing settings for WebSphere Application Server
Modify the publishing settings.
Runtime Environment. | WebSphere Application Server v8.5 - -
() Run server with resources within the workspace

- Server Set Ady Bakliching Settings...

& et e o S
Profile name:
(with write permission) dppSuOL b Minimize application files copied to the server

Application server name: serverl [¥] Automatically start applications after publishing

(This option may require manually starting your applications)

Enter settings for the WebSphere Application Server,

Update server status interval (in milliseconds): 5000

e (lose the WebSphere Application Server v8.5 configuration

*WebSphere Application Serverv&.5 at Localhu@

H Overview

e Save the configuration settings when prompted by clicking Yes

(=) Save Resource ===

‘@‘ 'WebSphere Application Server v&.5 at localhost' has been modified. Save changes?

Cancel

The workspace is now configured and you are ready to start developing code!
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e .
%\) Step 3 - Creating the “Development Model” (KEY STEPS!)

What’s this section about? A new Development project containing a development
model (previously referred to as a Hub Model) will be created in the workspace. You
must follow these steps to complete the tutorial.

Open the “context menu” (right hand mouse button) in the Package Explorer or
Navigator view (left hand portion of RAD window)
Select New -> Other... from the menu

5 EnterpriseE £ . ¥ Services| ' O

XN
New v F9 Project..
ShowIn AlteShift+W » | (5 05Gi Application Project
Copy T 4¥ 0SGi Bundle Project
Copy Qualified Name [ Application Client Project
T Paste CtrleV | i Connector Project
Delete Delete | g5 EIB Project
= .
s , | [ Enterprise Application Project
o [t i JPAProject .
4 Web Fragment Project
£ |GEicsh B |57 webProject
21 Markers 57 |2 Bample..

prer|

Description Uifrce

In the New wizard, select Master Data Management ->Development Project
wizard and click Next

() New o || ]

Select a wizard

Create a Master Data Management development project to extend physical
senvices.

Wizards:

type filter text

4 (= Master Data Management B

= Handler Class

¥ Inspector Configuration
i Job Set

(= Backwards Compatibility
(& Custom Service Interfaces
(= Extensions

Show All Wizards.

@ < Bad Einish Cancel

In the New Master Data Management Development Project window enter the
project name “FactoryAssetTracking”, the Base Java package name
“com.factory.asset.tracking” and click Next
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() New Master Data Management Development Project o [0
Master Data Management Development Project =
Create 2 Master Data Management develepment project to extend physical B
services.

FactoryhssetTracking

Use default location

Project namd

CAws\ws3\FactoryAssetTracking

Application Jocation:  C:\Pragram Files\BM\SDP Configure..

Base Java package namg(_ com factary asset.tracking

Service namespace URE  hitp://tracking.asset factory.com

e In the following panel enter “FactoryAssetTracking” for the Identifier
(previously Hub Base Name) and db2admin for the Database schema name.
Ensure that Add development project to composite is checked and that the
Composite project is set to FactoryAssetTracking.cba. Click Finish

() New Master Data Management Development Project o [0

Master Data Management Development Project Settings

Define the development project settings. j

Application level settings

Identifier: FactoryAssetTracking

db2admin]

Database schema na

Target runtime

websphere Application Server v8.5 =] [ Hew Buntime.

03Gi composite bundle membership

V] Add development projgctin.canaacite
Composite projedf,  FactoryAssetTracking.cha .

@ < Back

( Einish s Cancel
R

Hint: Once the project has been created you will be prompted to change to the MDM
Development perspective. You should click Yes to do this as certain menu options will
not be visible otherwise.

12) Open Associated Perspective? ==
'@‘ This kind of project is associated with the MDM Development perspective.

Model, generate, extend, customize and deploy Master Data Management selution
artifacts

Do you want to open this perspective now?

[ Remember my decision

When the wizard completes you will see that three projects have been created:

[# Package Explorer 22 . Data Source Explor| = O
& <
>+ FactoryAssetTracking
» &> FactoryAssetTracking.cba
> =% MDMSharedRescurces

FactoryAssetTracking — This is the “Development Project” that contains the solution
model file (module.mdmxmi) and eventually generated code.
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FactoryAssetTracking.cba — This is the composite bundle archive that will group
together one or more development projects for subsequent deployment - the CBA is
deployed alongside the MDM EBA to customize MDM. Although you can have more
than one CBA, its recommended that you add further development projects to the
same CBA project.

MDMSharedResources — This is similar to CustomerResources from previous
versions of the MDM. It groups together content that’s solution wide rather than
project specific (schema, SQL etc). Multiple projects contribute content.

e Open the module.mdmxmi file in the FactoryAssetTracking project and select
the Model tab. This will open the empty development model in the right hand
panel

0 FactoryAssetTracking &%
4 ‘?'7‘1 FactoryAssetTracking
[# src
» B\ JRE System Library [WebSphere Application Server

Development Module Model

Contents

4 & FactoryhssetTracking
(= FactoryAssetTracking

= build
(= BundleContent
mdmgen.properties

Ovame( Model ’
+ [Z( Problem ¥ Tasks| & Pro >

0 errors, 1 waming, 0 others

‘g\) Step 4 - Creating the four new Entity Types (KEY STEPS!)

What's this section about? In this section of the tutorial we will define the four new
Entity Types that form the core of the solution. These are Site, Building, Room and
MachineAsset. Initially these will be created without the relationships between them
which will be added later. You must follow these steps to complete the tutorial.

=entity_type= «entity_types
| Site | Building

[5g name : String | | 5 name : String

«entity_types
Room

(S name : String

] MachineAsset

[ name : String
[ serialMumber : String
oy description : String

e Open the context menu on the FactoryAssetTracking subfolder (shown below)
and select New -> Entity Type

Development Module Model

Contents AEED- Folder
Properties of the selected element
type filter tedt
Name:

4 ) FactoryfAssetTracking |
Documentation:

(= FactoryAssetTracking
New

Undo Ctri+Z tion URL
stion :

ransient Dats ubjec

Redo Ctrl+Y

of Cut

L] )

EZ  Entity Type Extension
#  Behavior Extension
2

= Copy 7 OQuerv Extension
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e In the right hand panel, change the name of the new Entity Type to Site

Entity Type
Properties of the selected element

eme:

Documentation:

Documentation URL:

Database table name: SITE
[] Support soft delete
Supertype: Browse... | | Clear

[T Allow subtypes

e Open the context menu on the Site Entity Type in the model tree view and select
New -> Attribute

Development Module Model

Contents oL = Entity Type
Properties of the

type filter text
Name:

4 & FactoryAssetTracking
4 (2 FactoryAssetTracking
™ S

[ Si=
New < Attribute >
7z @ Typelode Documentatior

<7 Undo Set Ctrl+
Redo Ctrl+Y (T Database table

Decumentatior

e In the right hand panel, change the attribute name to name, the type to String,
ensure that the Nullable field is not checked and that the Persistent field is
checked.

Tip: The default string length of 250 characters is fine for all String types you create
in this tutorial

Attribute
Properties of the selected element

Mame: name

Documentation:

Documentation URL:

[T Mullable
[¥] Persistent.

.;

Attribute field name: name
Database field name: name

Primary key

° Repeat this process to create the Entity Types Building and Room, both of
which should have a single String attribute called name.
° Repeat this process one more time to create the Entity Type MachineAsset

which should have attributes named name (String), serialNumber (String)
and description (String).

The Model should now look like this:
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#£0 FactoryAssetTracking [ Room

(= FactoryAssetTracking Roompkld
o Site
= name
Sitepkld & getRoom
name #, addRoom
# getSite #, updateRoom
% addSite 2 ROOM_BEFORE_IMAGE_NOT_POPULATED
updateSite ] MachineAsset
&) SITE_BEFORE_IMAGE NOT_POPULATED MachineAssetpkld
= Buildin
B g name
Buildingpkld serialNumber
name description
g' giiEBul\Eng ggetMa(h\naAssEt
addBuilding addMachineAsset
# updateBuilding #, updateMachineAsset
@5 BUILDING_BEFORE_IMAGE_NOT_POPULATED 5 MACHINEASSET_BEFORE IMAGE_NOT_POPULATED

Tip: The workbench automatically adds primary key fields and basic
Create/Read/Update/Delete (CRUD) style transactions for each entity you create.
For example you can add a new machine asset using the addMachineAsset
transaction or query rooms by primary key using the getRoom transaction. These
basic CRUD transactions are available for all entity types developed in the
workbench.

[ #{ An introduction to containment structures (BACKGROUND!)

What's this section about? This section provides a high level overview of what
containment relationships are and how they are represented in the development
model. Skip this section if required and refer to it as necessary.

In this model, a Site consists of a set of Buildings, a Building consists of a set of
Rooms and a Room contains a set of MachineAssets. We can establish these
relationships as “containment” relationships where we say a “containing” entity such
as Building “contains” another “contained” entity such as Room.

Exactly how this is modelled depends on the “cardinality” of the relationships and
here there are two key scenarios. Depending on whether the relationship is a “one-to-
one” or “one-to-many”, the workbench will create different model content when the
containment is defined.

“One to one” relationship:

In this case, the containing entity has a single contained entity underneath it. This can
be captured in the model as a simple reference from the containing entity to the
contained entity as shown below:

2l containingEntity [ containedEntity

- ContainedEntityReference

0.1

For example, if we assert that a Room only ever houses a single MachineAsset, we
could have a reference to a MachineAsset from Room. This is simplest case.
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“One to Many” relationship:

In many cases however, this is not realistic. For example a Room might well contain
many different MachineAssets. Whilst it is possible to create multiple references from
a ContainingEntity to different instances of the ContainedEntity, it is not possible to
create an arbitrary number of such references. Using this approach we would have to
know in advance exactly how many references were required and give them all
separate names in the model — this is impractical and messy.

The solution is to turn the problem around and have a reference from the contained
entity to the containing entity as shown in the model below:

| ContainingEntity [ containedentity

0.1

- containingEntityReference

For example a MachineAsset would have a reference to the Room in which it resides.
By doing this, we can associate an arbitrary number of MachineAssets with a single
Room.

As mentioned above, the workbench creates simple CRUD transactions to support the
data model. For example, the “getRoom” transaction returns a specific Room given a
primary key. If you introduce a one-to-many containment relationship, you will see an
additional transaction gets added to the model under the contained entity. This
additional transaction provides a service to retrieve all instances of the contained
entity that reference a given containing entity.

For example, when the transaction getRoom(53) is invoked to retrieve the Room with
primary key 53, it will include in the response all those MachineAssets that reside in
this specific room — derived by the reference from MachineAsset to Room. In this
case the transaction would be called “getMachineAssetByRoom™ and would return
all those instances of MachineAsset that have a reference to Room 53.

§ \) Step S - Creating “containment” relationships (KEY STEPS!)

What's this section about? The “containment” relationships between these key Entity
Extensions will be added to the model. You must follow these steps to complete the
tutorial.

To simplify this process, a wizard dialog is provided to automatically create the
required model components for a given containment structure. We will use this

wizard now to build up these relationships.

First, we will create the containment of Building within a Site:
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=entity_types
Site

53 name : String

1 |- siteReference
+ |- buildings
=entity_types

| Building
g, name : String

e Open the context menu on the Site Entity Type and select New ->
Containment...

£ *FactoryAssetTracking 3

Development Module Model

Contents & |3, O @ e~ | EntityType
Properties of the selected elem
type filter text
Name:
4 5] FactoryAssetTracking
4 (= FactoryAssetTracking Documen tation:
4| Site
> @ New » Attribute
> @ & tion URL:
, @< UndoRemove CtrlZ el aton
> @' Redo Culey Sincs 2ble nam
5, i
Cut
L % GerReCIT I
» £ 8|2 Copy
=] ! #  Tan Transaction ubtypes
=N RS ¢ Inquiry Transaction
#  Inquiry
=L
= ¥ Delete Error Reason
Library Object.
Refresh bl b

In the Containment Wizard dialog, enter a containment name buildings

Ensure the Allow multiple contained references option is checked

Ensure the Automatically create references and transactions option is checked
Click the Browse... button and select the FactoryAssetTracking ->
FactoryAssetTracking -> Building Entity Type.

e C(Click OK

@ Containment Wizard o || =) g
Create a containment
@ Contained entity type must be specified. -
Contsinment name:
o —

Contained entity type: "

Allow multiple contained instances
[¥] Automatically create references and transactions
Changes to bemadeto the develo] (5) Data Object Selection ===

Building Fra

4 3 FactoryAssetTracking

a Fetory Att®ilgacking
= Building

) G

e The Containment Wizard panel should then show a summary of the changes that
will be made to the model. Check this matches those listed below and click Finish
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() Containment Wizard = |2
Create a containment
—
Specify the details the containment to be added to entity type 'Site’. I_'_

Containment name: buildings

Contained ety ype  uting

[] Allow multiple contained instances

Automatically create references and transactions

Changes to be made to the davaloament model
Create Reference 'SiteReference’ in contained entity type 'Building’
Create GetRecord Transaction 'getAllBuildingBySite’ in contained entity type
‘Building"

4[] »

@ ¢ Fnisn [ Cance

e Open the context menu on the Building Entity Type and repeat this process to
create a new containment of Room named rooms.

(&) Containment Wizard = [@]==]

Create a containment

@ Contained entity type must be specified.

Containment name:  poms
- Contained entity type:
wentity_type=
B .‘H- [] Allow multiple contained instances
utlding [¥] Automatically create references and transactions
I_F'E name : 5tring Changes to be made f (=) Data Object Selection [o =
Room &
1 o 4 ) FactoryAssetTracking
- BuildingReference 4 (= FactoryAssetTracking
=1 Room
" - rooms
zentity_type= @
—| Room
|_F'E| name : 5tring
oK Cancel
e

e Open the context menu on the Room Entity Type and repeat this process to create
a new containment of MachineAsset named machineAssets.

(%) Containment Wizard o |[@] =]
Create a containment A
—
@ Contained entity type must be specified. r_‘_
«entity_types Containment name:  machineAssets
| Room Contained entity type
|__'|_—-E| name : 5tring [7] Allow multiple contained instances
[] Automatically create referepces and transaction
Data Object Selecti =
1 Changes to be made to the d ) Jeetseedion o -2
- RoomReference .
machine i

2 0 FactoryAssetTracking
# machinefssets 4 (2 FactoryAssetTracking

] MachineAsset
| MachineAsset

= narlne : String . @

El:"serlalNumber: String

_'—F'E description : 5tring

Coc 1D ona )
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The model should now look like this:

£ FactoryhssetTracking
(&= FactoryAssetTracking
= Site
Sitepldd
@ name
buildings
-Jﬁ? getSite
'&, addSite

%, updateSite

o8 SITE BEFORE IMAGE_NOT_POPULATED

7 Building
Buildingpkld
@® name
SiteReference
rooms
-ﬂ? getBuilding
2 getAlBuildingBySite
%, addBuilding
#, updateBuilding

4% BUILDING_BEFORE IMAGE_NOT_POPULATED

£ Room
Roompkld
name
BuildingReference
machineAssets
% getRoom
% getAllRoomByBuilding
#, addRoom
#,. updateRoom
&2 ROOM_BEFORE_IMAGE_NOT_POPULATED
1 Machinefsset
MachineAssetpkld
@ name
serialMumber
description
RoomReference
ﬁr’ getMachineAsset
ﬁ? getAllMachinedssetByRoom
% addMachineAsset
%, updateMachineAsset
&2 MACHINEASSET BEFORE IMAGE_NOT POPULATED

o
‘{;} Step 6 — New Code Table & Type Code for Room (KEY STEPS!)

What’s this section about? A code table is created to define the possible room types
that can be present in a building. We then create a “Type Code” reference to this
code type in the Room entity type. These steps must be followed to complete the

tutorial.

=] Room

ety types | e [ RoomType

«code_tables

[y hame String )

1

e Open the context menu over the FactoryAssetTracking subfolder (see below)

and select New -> Code Table

47 *FactoryAssetTracking £

Development Module Model

-
ERCIE Folder

Properties of the selected element

Name: FactoryAssetTracki

Contents o 15
type filter text
4 5 FactoryAssetTracking
4 (= FactoryAssetTracking
. BT Site New
. [ Building .
., B Room <2 Undo Add
. BT MachineAsset Redo
of Cut
=| Copy
Paste
¥ Delete
Refresh
Run As
Debug As
Profile As

Documentation:
» | (= Folder

CilaZ B  Entity Type

_— Transient Data Object

EZ  Entity Type Extension

Behavior Extension

X0 Traneacne

3¢ Inquiry Transaction
Error Reason
¥ |G Data Standardizer
2
2

e Select the new code table entry in the tree view and in the right hand panel,

change the name to RoomType

Page 20
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Code Table
Properties of the selected element

Narme: .RuomTypa

Documentation: | -

Documentation URL:

Database table name: CDROOMTP

e Open the context menu on the Room Entity Type and select New -> Type Code

Development Module Model

Contents S EE D Entity Type
i Properties of the selected eleme
type filter text
Name:
a &1 FactoryAssetTracking
4 (= FactoryhssetTracking Documentation:
> B Site
> [ Building
4| Reom n fatinn LIRL:
3 R New 3 Af
&g < Undoset Ctrle7 TelmmlRECOTE
.& Reference
> Redo New Type Code Crl+Y
@ g Containment...
 a gt o & Get Record
> g SLE ﬁ, Txn Transaction
> %“ Paste % Inquiry Transaction
R
. Mk K  Delete ﬂ Error Reason
R Bl Library Object...

e Select the new type code in the tree view and in the right hand panel change the
name to roomType

e (lick on the Edit button, select FactoryAssetTracking ->
FactoryAssetTracking -> RoomType in the Code Table Selection dialog and
click OK

Type Code
Properties of the selected element
Name: roomType
Documentation: -

Documentation URL:

Code Table d

[ Nullable

Persictent () Code Table Selection =3 ECR =)
Attribute field name: room|  RoomType &
Database field name: room| | 4 &) FactoryhssetTracking

Primary key 4 (= FactoryAssetTracking
¢ RoomType

C o) o

The model for the Room Entity Type should now look like this:

4 ] Room

. @ Roompkld

> @ name

» @ BuildingReference

» & roomType
machineAssets

. 4 getRoom

. % getAllRoomByBuilding

. #, addReom

> ﬁb updateRoom
&2 ROOM_BEFORE_IMAGE_NOT_POPULATED

Page 21 Copyright IBM 2013



Tip: We will add the various room types later once we have generated the code. This
is not something we capture in the model.

n e
%\) Step 7 - Extending the “Person” entity type (KEY STEFS!)

What’s this section about? In our model we need to be able to capture whether or not
a person has been trained to operate heavy machinery. We will create an Entity Type
Extension of the Person Entity Type to hold this information. These steps must be
followed to complete the tutorial.

«entity_type=
Person

‘Lexteﬂdsw

53 heawMachineryCertified : Boolean

«entity_extensions
Person

e Open the context menu on the FactoryAssetTracking subfolder (see below) and
select New -> Entity Type Extension

Development Module Model

Folder

Contents

type filter text

S EEEF-
Properties of the selected element

Name: FactoryAssetTracking

4 3 FactoryAssetTracking
4|(= FactoryAssetTracking
> 3 Site
> [ Building
. £ Room
. ] MachineAsset
- [T RoomType

)

ot

=| Copy
% Paste

Decumentation:
} | = Folder
E5 Entity Type
@  Transiept Data Ohject

L= Entity Type Extensicn

% Behavior Extension

New

Ctrl+Z
Ctrl+Y

Undo Set

Redo
Cut

?  Query Extension
s CodeTable

Extension in the tree view and in the right hand panel,

Click the Edit button and in the Entity Type Selection dialog select Party ->

e Select the new Entity Type
change the name to XPerson
[ ]
Party -> Person -> Person
e C(Click OK

Entity Type Extensiol
Properties of the seles

Name:

Documentation:

n
cted element

Documentation URL:

Database table nam

Extends:

XPERSOMN

e

[] Add fields to base table

[7] Qverride base qu

Page 22
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OEntrtyTypeSelect\on = @
Person -8

a 57 Party
4 [= Party
4 (= Persan
(e ze=enl)
[ Pereonilame
Co D e
e
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e Open the context menu on the XPerson Entity Type Extension and select New ->

Attribute

Development Module Model

Contents S EE D Entity Type Extension
Properties of the selected element
type filter text
Name: XPerson
4 59 FactoryAssetTracking
4 (= FactoryAssetTracking Documentation:
> B Site
> [ Building
» £ Roem Documentation URL:
» B Machinefsset
) RoomType Database table name: XPERSO
>l
4 |50 KPerson Extends: Person
> @ XPe New 6]
o sl =
o peL| & UndoSet cti+z Type Code
G REA - Redo Ctrl+Y Reference
&= 1ion & Error Reason

e Select the new attribute in the tree view and in the right hand panel change the
name to heavyMachineryCertified and the type to Boolean.

Attribute

Properties of the selected element
Name: heavyMachineryCertified

Documentation:

Documentation URL:

[] Nullable
[¥] Persistent

Attribute field name: heavyMachineryCertified

Database field name: heavy_Machinery_Certified

[T Primary key

e Open the context menu on the MachineAsset Entity Type and select New ->

Reference

Development Module Model

Contents

type filter text

4 50 FactoryAssetTracking
4 (= FactoryAssetTracking

. B Site

: £ Building

> 1 Room

4 |[7] MachingAsg
3 Maching
s (@ name r']
> serialMNu|
. @ descript
> Rnn-rT|Re of

New

Undo Set

Redo New Reference

Cut

name to owner

Party -> Person -> Person and click OK

Page 23

Ctrl+Z

Entity Type
Properties of the selected element
Name: Machine
Documentation:
Documentation URL:
3 Attribute MACHIM

Typ

% GetRecord

Select the new reference in the tree view and in the right hand panel change the

Click the Edit button and in the Entity Type Selection dialog select Party ->
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Reference

Properties of the selected element

MName:

Decumentation:

Documentation URL:

Beference type:
[[INullable
[¥] Persistent

Attribute field name:

Database field name:

Primary key

)

owner

owner

(D Entity Type Selection

Person

a 5 Party
4 (= Party

4 (= Paisaa
= Person
efiflame

" Cancel

Tip: Although we have extended Person with XPerson, remember that extensions are
really nothing more than “adjustments” to the underlying entity type. They should not
be thought of as subtypes which are a separate concept. For this reason we are
creating a reference to Person and not to XPerson. We are still able to pass the
extended field value for ‘heavyMachinaryCertified” when creating instances of

Person.

o
%\) Step 8 - Enforcing ‘addPerson’ transaction validation (KEY

STEPS!)

What’s this section about? We create a “behaviour extension” in the model which
will allow us to introduce some additional validation logic to the out of the box
“addPerson” transaction. The logic itself will be added later as Java code. For the
moment we must create a place-holder in the model. These steps must be followed to

complete the tutorial.

sbehavior_extensions
] MinimumAgeCheck

e Open the context menu on the FactoryAssetTracking subfolder (see below) and
select New -> Behaviour Extension
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Development Module Model

Contents S L EE D Folder

Properties of the selected element
type filter text

Name: FactoryAssetTracking
4 &7 FactoryAssetTracking |

4 (= FactoryAssetTracking Documentation:

. [ Site New b= Folder
. [ Building
» [ Room <7 Undo Set culz | EntityType
= Machinefszet | Redo New Reference cugey | ® Trensient Data Object
> [T RoomType B2 Enti pe Extension
S eemon O
= Copy e ey
) | Paste ET CodeTable
¥ Delete # Tyn Transaction
Refresh %  Inquiry Transaction
res| 7

e Select the new Behaviour Extension in the tree view and in the right hand panel
change the name to MinimumAgeCheck and the implementation type to Java

Behavior Extension
Properties of the selected element

Name: < MinimumAgeCheck >

Documentation: | -

Documentation URL:

Implementation: =

e Open the context menu on the MinimumAgeCheck Behaviour Extension and
select New -> Transaction Event

Development Module Model

Contents a4 = R Behavior Extension
z H &
Properties of the selected element
type filter text
Name: MinimumAgeCheck
4 57 FactoryAssetTracking
4 (= FactoryAssetTracking Documentation:
. BT Site
 EF Building
» 1 Room Documentation URL:
. BT MachineAsset . ;
» T RoomType Implementation: ava
; B2 XPerson
E] MinimumAgeCherk:
New b | = Action Event
& Undoset CtrleZ Transaction Event
Redo Ctrley = Action Category Even
= Transaction Category Event
o ||Cut & EmorResson
=] | Cory ODM Rule Data
Paste

e Select the new transaction event in the tree view and in the right hand panel set the
name to checkPersonAge

e Ensure the Pre option is checked

e C(lick the Edit button and in the Transaction Selection dialog select the Party ->
CoreParty -> addPerson transaction. Click OK.
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Transaction Event
Properties of the selected element

Name:

Documentation:

Documentation URL:

[pre

Priority: 1

Transaction:

theckPersonAge

@ Transaction Selection

addPerson

o | ]

4 2D Party
4 (= CorePart,
& 2ddPerzon

ﬁg addPersonName

Co D o

e Open the context menu on the MinumumAgeCheck Behaviour Extension and

select New -> Error Reason

Development Module Model

Contents

type filter text

o BB R Behavior Extension

Properties of the selected element

Name:

4 7 FactoryAssetTracking
4 (= FactoryAssetTracking
. B Site
> [ Building
> [ Room
» T MachineAsset
. [} RoomType
. Ed HPerson
4 i MinimysafasCharl:
= cheg New

Undo
Redo
Cut

Copy
Paste

W Nelete

Decumentation:

Documentation URL:

Implementation:

» | = Action Event
=p Transaction Event
= Action Category Event

Ctrl+Z
Crl+Y

) Validste model

Name to PERSON_UNDER_AGE

Error Reason

Properties of the selected element

Name:

Documentation:

Documentation URL:
Message:

Error type:

PERSON_UNDER_AGE

€ New Person entity must be over 16 years sy
< FVERR ) -

Select the new Error Reason in the tree view and in the right hand panel set the

Set the Message field to “New Person entity must be over 16 years”
Set the Error type to FVERR (Field Verification Error type)

e Repeat this process to create a second Error Reason with these properties:

Name - BIRTHDATE_FIELD MANDATORY
Message - BirthDate field must be provided
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Error type — FVERR

Name - UNABLE_TO_PARSE BIRTHDATE
Message - Unable to parse BirthDate field

Error type - FVERR

4 4 FactoryAssetTracking
4 (= FactoryAssetTracking
a [ Site
Sitepkld
name

buildings

4 getSite

B addSite

#, updateSite

B SITE_BEFORE_IMAGE_NOT_POPULATED

5 Building

Buildingpkld

name

SiteReference

rooms

& getBuilding

% getAllBuildingBySite

#, addBuilding

# updateBuilding

93 BUILDING_BEFORE_IMAGE_NOT_POPULATED

£ Room

Roompkld

name

BuildingReference

roomType

machineAssets

& getRoom

5 getAllRoomByBuilding

{i_ﬁ, addRoom

{iL updateRoom

62 ROOM_BEFORE_IMAGE_NOT_POPULATED

Now that the model is complete, it should look like this:

4 ] MachineAsset

> Machinefssetpkld

> name

3 senalNumber

> description
RoomReference
@ owner
& getMachinehsset
-}‘.‘z? getAllMachineAssetByRoom

> 'E@, addMachineAsset

> '@, updateMachinedsset

e Repeat this process to create a third Error Reason with these properties:

&2 MACHINEASSET_BEFORE_IMAGE_NOT_POPULATED

4 G} RoomType
> tp_cd
> name
a4 B XPerson
. @ XPersonpkld
heavyMachineryCertified

@ INSERT_EXTENSION_XPERSOM_FAILED
DELETE_EXTENSION_XPERSON_FAILED
READ_EXTENSION_XPERSON_FAILED

2 UPDATE_EXTENSION_XPERSON_
2 B MinimumAgeCheck

= checkPersonAge

&5 PERSON_UNDER_AGE

FAILED

&2 BIRTHDATE_FIELD_MANDATORY

&2 UNABLE_TO_PARSE_BIRTHDATE

e N
%\;} Step 9 - Generating code from the model (KEY STEPS!)

What’s this section about? Now that the model is complete, we need to create the
equivalent code to implement this solution. These steps must be followed to complete

the tutorial.

The bulk of the code will be automatically created by the workbench by running a
process referred to as “code generation”. Once the code has been generated, some
manual extension is required to configure the code table values and implement the
behaviour extension logic.

e C(lick the Generate code option at the bottom right hand side of the Development
Module Model panel
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o1 FactoryAssetTracking &3

Development Module Model

a S
Contents LD -

type filter text

4 o) FactoryAssetTracking
4 (= FactoryAssetTracking
» [ Site
£ Building
. £ Room
£ MachineAsset
57l RoomType
EZ XPerson =
. & MinimumAgeCheck BboCCl o

¥ Validate model

3, Import physical data model

[ Generate documentation

Overview | Model

e The Generating... dialog shows the progress of code generation.

(2) Generating .. o -5 [EES

"6" Executing templates

templates/mdmController/component/BNComponentAdd.inc jet

["JEiways ran in background:

Run in Background| | Cancel | [ Details »»

Tip: Once code generation is complete you should check to see if there are any errors
in the Problems view. If there are problems this indicates that something has failed
during code generation and you will need to investigate further.

[} Problems £2 . @ Javadoc| [, Declaration | T3 Annotations

0 errors, 380 wamnings, 0 others (Filter matched 100 of 380 items)

Description ‘ Resource Path Location  Type
. @ Wamings (100 of 330 items)

o
%\) Step 10 - Implementing the behaviour extension (KEY STEPS!)

Whats this section about? We add the Java code required to implement the
behaviour extension. You must follow these steps to complete the tutorial.

As discussed above, we need to add a behaviour extension to ensure that no-one under
16 years of age can be added to the system using the “addPerson” transaction. Code
generation will have created a template class that must be manually modified to
implement the required logic.

e Open the generated source code file MinimumAgeCheck.java from the
FactoryAssetTracking/src/com.factory.asset.tracking.behaviour folder
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[% Package Explorer 2
a FactoryAssetTracking
4 7% src
4 1 comfactory.asset.tracking.behaviour
& | MinimumAgeCheck.java

. iB com.factory.assettracking.bobj.query

Tip: This file contains a blank execute method that will be triggered each time the
addPerson transaction is invoked. We will need to add code to this method to make
the necessary age checks and reject any transactions where the party is less than 16
years old.

public class MinimumlgeCheck extends ClientJavaExtensionSet {
S
% <l-— begin-user—dog —->
* <!-- end-user-doc -->

* The execute method will be called in ease of extension activation.

«
=
public void execute(ExtensionParameters params] {
/¢ MDM TODO: Write gustomized business logic for the extension here.
¥

il

e Replace the MinimumAgeCheck.java file in the workspace with the version
supplied with this tutorial.

Tip: This replacement code extracts the root business object from the request (an
instance of TCRMPersonBObj) obtains the birth date from it and uses this to evaluate
if the person is older than 16 years. If the birth date field is not provided, can’t be
parsed, or was less than 16 years ago from the current time an error is reported and
the transaction is aborted.

H .
@-i\;) Step 11 - Customizing the Code Table values (KEY STEPS!)

What's this section about? We configure the possible values for the RoomType Code
Table. You must follow these steps to complete the tutorial.

As previously discussed, the RoomType provides a mechanism for defining a set of
possible room type strings. In this example, we will use the following set of room

types:

e Office

¢ PlantRoom

*  MeetingRoom
¢ StoreRoom

Tip: These String values are NOT stored in the Development model. The generated
SOL must be manually modified to add the required values.
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When code is generated for the model, an SQL file named

FactoryAssetTracking CODETABLES DB2.sql is created in the workspace under
FactoryAssetTracking\resources\sql\db2.

[£ package Explorer 2 Data Source Explorer
4 T2 FactoryAssetTracking
5 sre
=, JRE Systern Library [WebSphere Application Server Va.5 JRE]
= Plug-in Dependencies
= build
» [ BundleContent
4 4= resources

7= sampleRequest

4 (= ql

4 = db2

| FactoryAssetTracking_CODETABLES_DB2.sql

1 Facto

E FactoryAssetTracking_MetaData_DB2.sql
T P koA e oaT e i O

This file contains INSERT statements to a add 4 sample values to the CDROOMTP

database table as shown below:

IHSERT IHTO chiadmin.CDROOMTP { lang tp cd, tp_cd, name , description,

VALUES ( 100, 1, 'namel’

, HULL, CURRENT TIMESTAMP, 'cusadmin' ):

IHSERT IHTO chiadmin.CDROOMTP { lang tp cd, tp_cd, name , description,

VALUES ( 100, Z, 'nemei'

, HULL, CURRENT TIMESTAMP, 'cusadmin' ):

IHSERT THTO dbZadmin.CDROOMTP [ lang tp cd, tp_cd, name , description,

WALUES | 100, 3, 'name3’

CURRENT TIMESTAMP, 'cusadmin' ):

IHSERT IHTO cdbiadmin.CDROOMTP ( lang tp cd, tp_cd, nawme , description,

VALUES | 100, 4, 'named’

CURRENT TIMESTAMP, 'cusadmin' ):

last_update_drt, last_update_user

last_update_dr, last_update_user

last_update_dt, last_update_user

last_update_dt, last_update_user

This SQL setup file, along with the others in the same folder are combined together to

create a single SQL setup file named Setup DB2.sql in the

MDMSharedResources\sql\db2 folder as shown below. This process is dynamic and
any changes to the SQL files in the FactoryAssetTracking project are automatically
incorporated into the single merged file.
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[ Package Explorer 52 . Data Source Explorer =
# FactoryAssetTracking
B sre
B JRE System Library [WebSphere Application Server V8.5 JRE]
=i Plug-in Dependencies
= build
(&= BundleContent
i resources
£ sampleRequest
= sql
(= db2

E FactoryAssetTracking_ CODETABLES_DB2.=ql

[B FactoryAssetTracking_CONSTRAINTS_DB2.sql

B FactoryAssetTracking_MetaData_DB2.sql

[ FactoryAssetTracking_SETUP_DB2.5ql
FactoryAssetTracking_TRIGGERS_DB2 sl

Rollback_FactoryAssetTracking_CONSTRAINTS_DB2.sql
[ Rollback_FactoryAssetTracking_ MetaData_DB2.sql
[ Rollback_FactoryAssetTracking_SETUP_DB2.sql
[ Rollback FactoryAssetTracking_TRIGGERS_DB2.sq
= oracle
&= zos
[ setup_DB2.5ql
1) jevadocaml
mdmgen.properti
11 mdmgen.ml
£ module.mdmig
{&= FactoryAssetTrackifg
= MDMSharedResourclis
= modules
(= properties
= schema
= sql
B Rollback_DB2.sgl
B Rollback_ORACLE.sql
[ Rollback_ZOS.=ql
el oetup_DBZ.sgl =2
| Setup_ORACLE.sql
[ Setup_z0S.sq)
£0 application.mdmxmi

Tip: The Rollback ... scripts are merged in a similar way into the Rollback DB2.sql
file

Tip: Merged script files are also created for the Oracle and zOS database platforms
but they are not used within this tutorial.

Tip: In this case FactoryAssetTracking is the only development project within the
workspace. If you create other development projects and generate code, then the SOL
files in those projects are also incorporated within the merged master SQOL files.

In order that we can modify the values for the Code Table without them being
overwritten during code generation we will modify a copy of the master SQL files.
You will need to manually maintain this file if further changes are made to the model
so that the SQL files in the MDMSharedResources folder are changed.

e Take a copy of the Setup_DB2.sql script from the MDMSharedResourcessql
folder and place it into the FactoryAssetTracking\resources folder
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[# Package Explorer i1 Data Source Explorer
4 T FactoryAssetTracking
72 src
» = JRE System Library [WebSphere Application
- = Plug-in Dependencies
= build
> [ BundleContent

N

i resources
= sampleRequest
= sql
[ Setup_DB2.sql

[, Setup_DBZ.sql

[, Setup_ORACLE.sql

[ Setup_Z0S.sql
47 application.mdmxmi

e Open the copied version of the Setup DB2.sql file, scroll to the end and locate
the configuration statements for the Code Table as shown below:

INSERT INTO dbZcdmin.CDROOMTP { lang tp_cd, tp_cd, newe , description, last update dt, last update user
VALUES | 100, 1, 'mamel’ , WULL, CURRENT TIMESIAME, 'cusacmin' |;

INSERT INTO dbZachwin.CDROOMTP ( lang tp od, tp_cd, name , description, last_update_dt, last_update_user
VALUES | 100, 2, 'name2' , HULL, CURRENT TIMESTAMP, 'cusadmin' );

INSERT IHTO dbZachuin.CDROOMTP | lang tp cd, tp_cd, nsme , description, last_update_dt, last_update_user
VALUES | 100, 3, 'name3' , HULL, CURRENT TIMESTAMP, 'cusadmin' );

IHSERT INTO dbZacmin.CDROOMTF ( lang_tp_cd, tp_cd, name , description, last_update_dt, last_update_user
VALUES | 100, 4, 'nemed' , NULL, CURRENT TIMESTAMP, 'cusadmin' );

e Replace the namel, name2, name3 and name4 values with the required
RoomType values as shown below:

INSERT INTO chZadmin.CLROOMTP { lang tp_cd, tp_cd, name , description, last update dt, last update user |
VALUES | 100, 1, 'Office’ , WULL, CURRENT TIMESIAME, 'cusadwin' |:

INSERT IHTO dbZadwin.CDROONTP { lang tp od, tp od, nawe , descriprion, last_update dt, last_update user |
VALUES ( 100, 2, 'PlantRoom' , WULL, CURRENT TIMESTAMP, 'cusacdwin' );

INSERT IHTO dbZadwin.CDROONTP { lang tp od, tp od, nawe , descriprion, last_update dt, last_update user |
VALUES | 100, 3, 'MestingRocom' , WULL, CURREMT TIMESTAMP, 'cusadwin' );

INSERT INHTO dbZacdwin.CDROONTP [ lang tp cod, tp_cd, nawe , descriprion, last_update_dt, last_update_user |
VALUES [ 100, 4, 'StorsRoom' , HULL, CURRENT TIMESTAMP, 'cusadwin' j;

o
{;} Step 12 - Deploying the code (KEY STEPS!)

What's this section about? - Code developed in the workspace will be deployed to the
WebSphere application server. You must follow these steps to complete the tutorial.

Now that the development is complete, the workspace should contain the following
projects with code generated ready for deployment:

[# Package Explorer £2 [ Data Source Explor

4| 0O

=k
. ¥4 FactoryAssetTracking

» 2 FactoryAssetTracking.cha
+ = MDMSharedResources
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The first step is to deploy the Composite Bundle Archive
‘FactoryAssetTracking.cba’ to WebSphere:

e Open the Servers view and locate the target WAS server (eg WebSphere
Application Server v8.5 at localhost). Check to see if the server is Started

[ Problems | ] Tasks | = Properties | 4k Servers £3 . 5 Progress| B Console| B 5QL Results

Ea ‘Web Preview Server [Stopped]
WebSphere Application Server v8.5 at local @

e If the server is Stopped, start it by opening the context menu on the server
definition and selecting the Start option. Wait for the server start-up to complete.

Rename F2
35 Debus Ctrl+- Alt-D
<i§ Start CtriAlt R
& Profie
Stop Ctri+AltsS
ED Publish CtrleAlt=P
Clean...

f&  Add and Remove...
Monitering »

[J Create Tables and Data Sources

B8 Deactivate server

Reconnect Debug Process

Administration »
Universal Test Client »

roblems [ ] Tasks | =] Properts ervers j Pragress| erver Configuration
21 probi Tasks | = Prop: 4k 5 i3 Prag Server Configurati »
L Web Brevien Server Dloiay operties Alt+Enter

Server vB.5 at localhost [Stopped, Synchromees:

e  Open the context menu for the server definition and select Add and Remove...

[£ Problems | 2] Tasks | = Properties | 4fb Servers £2 . 53 Progress| =1 SQL Results| B Console | 47 Search
[EL, Web Preview Server [Stopped]

WebSphere Application Server v&.5 at localhost [Started, §—-———"

New 3
Open =]
Show In Ale+Shift+\W »

=| Copy Ctrl+C
Paste Ctrl+V

¥ Delete Delete
Rename F2

%5 Restart in Debug Ctrl+Alt+D

2 Restart Ctrl+ Alt+R

@5 Restart in Profile

Stop Ctrl+Alt+S

L Publish Ctrl+Alt+P
Clean...

T it and Femove. -

Monitoring 3

e Inthe Add and Remove... dialog select the CBA to be deployed from the
Available list and click Add > to move it to the Configured list
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(2 Add and Remove... o |[-E-] =3

Add and Remove ’ ‘

Modify the resources that are configured on the server

Move resources to the right to configure them on the server

Available:

ﬁ
( A5 FactoryAssetTracking.cha )

Configured:

Coe D

< Remove

[#] ¥ server is started, publish changes immediately

e Click the Finish button to publish the CBA to the server.

() Add and Remove... =R =R ==
Add and Remove =
Modify the resources that are configured on the server

Move resources to the right to configure them on the server

Availsble: Configured:

4& FactoryAssetTracking.cha
Add >

< Remove

[#] f server is started, publish changes immediately

=

: —
@ TN BTN () N

e Wait for the Server connection to become Synchronized again

4 WebSphere Application Server v8.5 at localhost [Started, Synchronized]

Tip: The CBA is published to the server but not yet associated with a Business Level

Application. Before it can be used, it must be configured as a Composition Unit
Extension...

e In the Servers view, expand the server connection to reveal the published CBA.
Open the context menu for the CBA and select Manage Extensions.

[21 Problems | ¥ Tasks | =l Properties | = Progress | 4 Servers &2 . E] Console | 47 Search
£ Web Preview Server [Stopped]
4 B8 WebSphere Application Server v.5 at localhost [Started, Synchronized]
> |9F FactoryAssetTracking.cba [Synchronized]
New »
Start
Stop
Restart

K Remove Delete
€ZE_Manage Extensions —_
&y Show In Bundle Explorer

Properties Alt+Enter

e Inthe Manage Extensions dialog, expand the Advanced section.
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(3 Manage Extensions

Manage Extensions

Select applications to extend. Deselecting applications will remove existing extensions.

o [

oy

2

Select All

b Advances

@

i

existing deployed applications.

Click the Get information from server button to retrieve information about

(% Manage Extensions

Manage Extensions

Select applications to extend. Deselecting applications will remove existing extensions. :{_|

o

|

&

Select All

~ Advanced

warkspace.

Extend an application that is deployed on the server but not in the

Business-level application: |

Composition unit:

('l Get information from server |}

When the Business-level application dropdown appears, select the target

application (in the case of MDM Server this is MDM-operation-server-EBA-

E001).
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{2} Manage Extensions
Manage Extensions

Select applications to extend, Deselecting applications will remove existing
extensions.

Select Al

HHLS

Deselect Al

~ Adranced

Extend an application that is deployed on the server but not in the

S

sl [
] Defaulthpplication

Compasition unit EMuTe

MDM-native-E001

@

MDM-web-services-virtual-E001

ivtApp

query

e  When the Composition unit dropdown appears select the target Composition
Unit (in the case of MDM Server this is com.ibm.mdm.hub.server.app-

E001_0001.eba)

(2) Manage Extensions ==
Manage Extensions JD
|
L

Select All

Deselect Al

Select applications to extend. Deselecting applications will remove existing
extensions,

A

~ Advanced

Extend an application that is deployed on the server but not in the
workspace.

LT PR RN T T VDM - operational-server- EBA-E001 -

Composition unit:

= ~am,ibm.mdm.hub.server.app-E001_0001.eba
com. b TS e TEC PP eEE PPE e €5 F001_0001 jar

@

e Click Finish to apply this configuration

Page 36

Copyright IBM 2013



@ Manage Extensions

Manage Extensions

Select applications to extend. Deselecting applications will remove existing
extensions,

Select All

1i %

Deselect Al

~ Advanced

Extend an application that is deployed on the server but not in the
workspace.

Business-level application: MDM-operational-server-EBA-E001 -
Composition unit: m.ibm.mdm.hub.server.app-E001_0001.eba R4

Get information from server

i W
‘\?/' Einish Cancel

el

e The Manage Extension dialog will appear whilst this configuration is performed.

(=) Manage Extensions o e s

.'6‘. Associating composite bundles with applications

Running extension command

[ [Eiways ran in background:

Runin Background| [ Cencel | [ Details>»

e Once the process is complete, check the Server connection status again and wait
for it to become Synchronized

4 WebSphere Application Server v8.5 at localhost [Started, Synchronized]

Tip: Although the CBA is now fully deployed, the Database configuration must be
applied before it can be invoked. The next step is to setup a connection to the MDM
database and run an SQL script to apply the necessary configuration.

ﬁ e
‘{;} Step 13 - Deploying the metadata configuration (KEY STEPS!)

What's this section about? - Configuration settings will be deployed to the DB2
database. You must follow these steps to complete the tutorial.

e In the Servers view, open the context menu on the server connection and select
Stop.
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Ctrl+Alt+R

yead)

§J Restart

Clean...

& Add and Remove..

Monitaring 3

[] Create Tables and Data Sources

Deactivate server

Reconnect Debug Process

Administration 3
Universal Test Client 3

21 Problems | ¥ Tasks | = Properties | 47 Servers £3 Server Configuration Y

Ea Web Preview Server [Stopped] Properties
WebSphere Application Server v8.5 at localhost [Started, synenronize]

=5 P
Alt+Enter

e Wait for the Server connection to become Stopped
WebSphere Application Server v8.5 at localhost [Stopped, Synchronized]
e Sclect the Data Source Explorer view and expand Database Connections
e Open the context menu on the MDM database connection (MDM11DB) and
select Properties
@ MDM Development - Rational® Application Developer for WebSphere® Software
File Edit Navigate Search Project Run  Master Data Management Window Help
-5t
4 = Database Connections
E4 BB assichiode Sample Database
G /DM110B [DB? Aizz] 23
4 (= ODA Data bources Connect
(= Classic ModelsInc. ¢ Disconnect
2= Flat File Data Source Ping...
(= JDBC Data Source
(= Web Services Data § Work Offline
2= XML Data Source Save Offline
Rename F2
Delete Delete
Duplicate
Open 5QL Scrapbook
Add JDBC Connection to Project...
323 Create EJBs from Tables (Lx-2.x)
e In the Properties for MDM11DB dialog, Select Driver Properties in the left

hand panel, open the General tab in the right hand panel and update the User
name and Password fields if necessary. The default values for the MDM Typical
Workbench installation are:

DB2 User name : db2admin
DB2 Password: db3Admin
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(2} Properties for MDMI11DB

type filter text

Commeon

Default Schema Filter
Default Stored Procedure F
Def ahle Filter

Driver Properties

Versio

« [ [ r

o [o] ]

Driver Properties - v v

Drivers: [IBM Data Server Driver for JOBC and SQUI Default -l & A

Properties

General | Tracing | Optional

Databage: MDM11DB

Host: localhost

Port number: 50000

User name:
Password:

Save password
Default schema:

Connection URL:  jdbe:db2://localhost:50000/MDMI1DE:retrieve »
M, FromServerOnGetMessage=true;

ETest Connection

e C(lick the Test Connection button to determine if these settings are correct. You
should see the Success dialog after a few seconds. Click OK to dismiss this

window.

{5 Success

.ﬁ. Ping succeeded!

e Once you have confirmed the connection to the database is correctly setup, close
the Properties for MDM11DB dialog by clicking OK

4 [ n b

Test Connection

e Sclect the Package Explorer view
e Locate the Setup DB2.sql script that you modified in step 11.
e Open the context menu over this file and select Open With -> SQL and XQuery

Editor

4 f;”; FactoryAssetTracking

s 8 src

> B JRE System Library [WebSphere Application Server V8.5 JRE]

> =i Plug-in Dependencies
(= build
: [ BundleCentent
4 = resources
» = sampleRequest

|
[B Setup_DB?-=al
@Javado(.xm\ New
d .
mdmgen.pr Tomr
_;@ mdmgenxm

40 module.mdr Open With
» {2 FactoryAssetTral Show In
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e Open the context menu anywhere in the SQL file and select Use Database
Connection...

—- T2, THE INFLIED VWARRANTIES ©R COMDITICNS ©F MERCHANTABILITY,

FITHNESS FOR A

—— PARTICULAR PURPOSE, AND NON-INFRINGEMENT, REGAI
—- IEN EE LIAELE TO VOU OR AMY PARTY FOR AMY DIREC
—- CONSEQUENTIAL DAMAGES FOR ANY USE OF THE CODE,
—-- LO35 OF, OR DAMAGE TO, DATA, OR LOST PROFITS, H
—— MNTICIPATED SAVINGS, EVEN IF IEM HLS BEEN LDVIZ
—- DAMAGES. SOMNE JURISDICTIONS DO NOT ALLOW TIHE E
—- INCIDEWTAL OR CONSEQUENTIAL DAMAGES, S0 THE AB
—— NOT APPLY TO YOU.

-- Notes

4 —— MDN TODO: statements are placed in the generat
-- 1. Edit the following 5QL files following anv &
-- Z. Connect to the database.
—= 3. Fun each 3QL file as shown below and in the
- dhi —-vi FactorylAssetTracking SETUP_DEZ
- dhZ -vf FactoryissetTracking TRIGGERS |
— dhi —vi FactorylissetTracking CONSTRAII
- chi —vi FactoryissetTracking MetaData |
- dh2 -vf CONFIG_XMLSERVICES RESPONSE_DE
— dhi —vi FactorylissetTracking CODETLELE

Fh

—-#SET TERMINATOR ;

CREALTE TABLE dbZadmin.3ITE |
Sitepk_Id BIGINT NOT NULL
nawe VARCHALR(250) MNOT NULL

LAST_UPDATE_DT TIMESTAMF NOT NULL  WITH DEF
LAST UPDATE TX ID BIGINT
LAST_UPDATE_USER VARCHAR(Z0)

i &

ALTER TABLE dbZadmin.SITE
ann_pOTMADY TRV
4 n

-34 Problems 2, Tasks | =] Properties | 55 Progress I Console | 4 Search

Undo
Revert File

Save
Show In

Cut

Copy

Paste

Run As
Debug As
Profile As
Validate
Software Analyzer
Team
Compare With
Replace With

Preferences...

Content Assist
Content Tip
Format SQL
Toggle Comment

v | Validate Statement Syntax

Ctrl+Z

Ctrl+S
Alt+Shift+W b

Ctrl+X
Ctrl+C
Ctrl+V

Ctrl+Space
Ctrl+Shift+ Space
Ctrl+Shift+F
Ctrl+/

Use Database Connection...

Run 5QL
Set Statement Terminator

Validate Table References

F5

= £l

e In the Select Connection Profile dialog, select the MDM11DB database
connection and click Finish

{2 Select Connection Profile

Select Connection Profile

Connections

Select a connection profile from the list below or click the New... button to create a new connection profile.

= -5zl

gssic Models Sample Database

~ Properties

Property Value

Name MDML1DE
Description

Category Dstabase Connections
Database MDML1DE

JDEC Driver Class
Class Location
Cennection URL
lser 1D

com.ibm.db2 jec.DB2Driver

Ah2admin

C\Program Files (x86)\[BM\IBMIMShared?,..
jdbe:db2://localhest:50000/MDMLLDE: retri...

[

Tip: This associates the specific SOL file with the MDM11DB connection. When the
script is subsequently executed, this is the database connection that will be used.

e Open the context menu anywhere in the SQL file and select Run SQL
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-- Td, THE INPLIED WARRAWNTIEZ OR CONDITIONZ OF MERCHANTAEILITY, FITMESZ FOR A

—-- PARTICULAR PURPOSE,

AND NONM-INFRINGEMENT, REGALF

—- IEM BE LIABLE TO ¥OU OR ANY PARTY FOR ANY DIREC Undo Ctri+Z
-- CONZEQUENTIAL DAMAGES FOR ANY USE OF THE CODE, Revert File
-- LOSS OF, OR DAMAGE TO, DATA, OR LOST PROFITS, B Save Ctrl+S
-- ANTICIPATED SAVINGS, EVEN IF IEM HAS BEEMN ADVIZ
-- DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE E Show In Alt+Shift+ W »
-- INCIDENTAL OR COMSEQUENTIAL DRMAGES, 30 THE LB
-- NOT AFPLY TO ¥YOU. Cut Ctrl+X
Copy Ctrl+C
§ |-~ Noces Paste Ctriev
f -- MDM_TODO: statements are placed in the generat
-- 1. Edit the following 0L files followving any & Run As 3
-- 2. Connect to the database.
. Debug As v
-- 3. Run each 0L file as shown bhelow and in the
- dhz -vf FactoryissetTracking SETUP_DB2 Profile As 4
- dh2 -vE FactoryissetTracking TRIGGERZ | Validate
-- @hz -vE FactoryhsserTracking COMSTRAT SfirErfndaT D
-- bz -vE FactoryissetTracking MetaData |
-- @hi -vi CONFIG_XNLZERVICES RESPONSE_DE Team 4
-- dhz -vi FactoryissetTracking CODETAELE Compare With 3
Replace With 3
—-#SET TERMINATOR @
Preferences...
Content Assist Ctrl+Space
-- BiglinipperPrioricy 300 Content Tip Ctrl+Shift+Space
Format S5QL Ctrl+Shift+F
-- The following source code ("Code") way only he
-- and conditions of the license agreement you he Toggle Comment Crl+/
T e e e v | Validate Statement Syntax
LProblems ETasks =] Properties | 5 Progress El console Q;‘ Search Use Database Conneelion.
E, Web Preview Server [Stopped] S Run sl
WebSphere Application Server v8.5 at localhost [Started, Synchronized] Set Statement Terminator
2E FactoryAssetTracking.cha [Synchronized] Validate Table References

e The statements in the SQL file will be executed to configure the MDM database.
Progress is displayed in the SQL Results view that will open in the workbench.

WATITES o

1nn. 3. 'MestincRoom' . WITLT. .

CITRRFEMT TTMESTAME .

temmadmin' b

<

I

[2l Problems | ¥ Tasks | = Properties | 53 Progress | &l Console | 47 Search | 4 Servers | @] Error Log | =] SQL Results £3

Type query expression here

v Succeeded
v Succeeded
v Succeeded
v Succeeded
v Succeeded
v Succeeded
v Succeeded
v Succeeded
v Succeeded

4 " Succeeded

Operation

Setup_DB2.sqgl

CREATE TABLE db2admin.SITE ( Sitepk_Id BIGINT
ALTER TABELE db2admin.SITE  ADD PRIMARY KEY
CREATE TABLE db2admin.BUILDING { Buildingpk_
ALTER TABLE db2admin.BUILDING ADD PRIMAR
CREATE TABLE db2admin.ROOM ( Roomplk_Id BI
ALTER TABLE db2admin.ROOM  ADD PRIMARY K
CREATE TABLE db2admin.MACHINEASSET ( Mac
ALTER TABLE db2admin.MACHINEASSET ADD PI
CREATE TABLE db2admin.COROOMTP ( lang_tp_
ALTER TABLE db2admin.COROOMTP  ADD PRIM.

Status

INSERT INTO db2admin.GROUPTAMAP (ENTITY_TX_MAP_Il
WVALUES (1000508, 'SiteBObj', 'TCRM', 1000006, CURRENT T
INSERT INTO db2admin.GROUPTAMAP (ENTITY_TX_MAP_Il
WVALUES (1000509, 'BuildingBObj', TCRM', 1000021, CURRE
INSERT INTO db2admin.GROUPTAMAP (ENTITY_TX_MAP_Il
VALUES (1000510, 'RoomBObj', ‘'TCRM', 1000034, CURREN
INSERT INTO db2admin.GROUPTAMAP (ENTITY_TX_MAP_Il
WVALUES (1000511, 'MachinefssetBObj', 'TCRM', 1000047, ¢
INSERT INTO db2admin. EXTENSIONSET (EXTENSION_SET_IL
WVALUES (1000107, 'checkPersonAge’, null, 'com.factory.as:
INSERT INTO db2admin. CDCONDITIONVALTP (COMND_VAL_
WVALUES (1000512, 1, 'addPerson’, CURRENT TIMESTAMP)
INSERT INTO db2admin. EXTSETCOMNDVAL (EXTSET_COMNDY
WVALUES (1000513, 1000512, 1000107, CURRENT TIMESTAM
TNSFRT TNT( dh?admin FXTSFTCOMNDVAL (FXTSFT COMNDV

Tip: You should check to see if the overall process Succeeded or if individual
statements failed. Where failures do occur, it may be that a previous deployment is
causing conflicts (e.g. a table already exists). You can either resolve such issues by
hand or try to remove a previous configuration using the “Rollback” scripts created
alongside the Setup script before re-running the setup scripts.

Once the database is configured its time to restart the WAS server:

e Open the Servers view and locate the target WAS server (eg WebSphere
Application Server v8.5 at localhost).
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e Open the context menu on the server definition and select Start. Wait for the
server start-up to complete

Rename F2

35 Debu Cirle Alt+D
<i§ Start CtrlAlt- R
& Profile
Stop Ctrl+Alt+S
F0 Publish Ctrl+Alt-P
Clean...
fEr Add and Remove...
Monitoring »

[J Create Tables and Data Sources
Eé Deactivate server
Reconnect Debug Process

Administration »

Universal Test Client
[£1 Problems [ ] Tasks [E < | 45 S 53 Progress Server Configuration »
erver 8.5 a ot [Stopped, Synchirees
acTory Raselt

L Web Preview roperties AltEnter

Note: The accompanying document “MDMWorkbenchV'11Deployment” provides
more detail about the development process including:

*  How to remove a CBA from the server
*  How to export the CBA from the workbench and install this via the
WebSphere admin console.

ﬁ .
{\) Step 14 - Testing the Solution (KEY STEPS!)

What's this section about? - Now that the code is deployed and configured this
section shows how the services it provides can be invoked and tested.

The code can be tested by running a series of transactions against the server to create
and retrieve instances of the Entity Types defined by the model. The transaction
documents are supplied in an archived project for your convenience.

e Switch to the Package Explorer view, open the Context menu and select
Import...

[% Package Explorer £ . Wi Data Source Explorer

> g FactoryAssetTracking
. 2 FactoryAssetTracking.cba
» = MDMSharedResources

New 3

Show In Alt+Shift+W
Copy Ctrl+C
Copy Qualified Name

5 Paste Ctrl+V
Delete Delete

&L Impott.. -
ey Export...
" Refresh F5

e In the Import dialog, select General -> Existing Projects into Workspace and
click Next
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(5} Import
Select

Create new projects from an archive file or directory.

Select an import source:
type filter text

Lo o=

N

2=

4 (= General
[, ArchiveFile

R s P e o
L basting REDB.X Dats Detinition Project
(7, File System
L Preferences

> (= CloverETL

» (= Code Coverage

i »

Finish

Cancel

e In the Import dialog, Select the Select archive file option and click Browse...
e In the Select archive containing the projects to import dialog, locate the
supplied SampleTransactions.zip file and click Open

(&) Import

Import Projects

Select  directory to search for existing Eclipse projects.

7 Select root directory:

Projects:

: (@ Select archive file =%

= [[=]E=]

i

<

Browse...

G )
e

Copy pi
Working
D Addp

{2} Select archive containing the projects to import

@vv\f; + Computer » Local Disk (C) »

Organize »  New folder

i Name

Perflogs
| Program Files
Program Files (:86)

E | ProgramFiles

¢ Favorites
B Deskiop
& Downloads

] Recent Places

4 Libraries Software
| Documents Users
o) Music | Windows
=] Pictures g
B Videos S wsl

1) sampleTransactions

Date modified

13/07/2009 23:20
05/06/2013 17:40
05/06/2013 17:37
05/06/2013 17:53
05/06,/2013 17:27
05/06/2013 17:42
05/06/2013 18:24
06/06/2013 04:43
06/06/2013 04:42
07/06,/2013 08:08

- 4

8 Comnuter

.

Type
File fol
File fol
File foll
File foll
File foll
File fol| =
File foll
File foll
File foll

Comp +

e  Ensure the SampleTransactions (SampleTransactions) option is checked and
click Finish. This will import the projects containing the sample transactions into

the workspace
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(=) Import

Import Projects

Select a directory to search for existing Eclipse projects.

) Select roct directory:
@ Select archivefile  C:\SampleTransactions.zip

Projects:

Browse.
Browse.

s)

SampleTransactions (SampleTransaction

Copy projects into workspace
Working sets
[] Add project to working sets

Select All
Deselect All

S

< Back

& TEST I - Creating a Site with associated content...

The first XML transaction file we will run is called createTestSite.xml. It will create a
new Site instance called “TestSite1”. Contained within the new site will be a single
Building instance called “TestBuilding1”. Contained within the new building will be a
single Room instance of type PlantRoom called “TestRoom1”. Finally, the Room will
have two machine assets listed, TestMachineAsset1 (serial MA0001) and
TestMachineAsset2 (serial MA0002). Both of these machine assets are owned by the
Person instance created by the MDM Server Installation Verification Test (primary

keyis 91111111)

Examine the createTestSite.xml document shown below to understand its structure:
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<TCREMZervice xmlns:xsi="http:/Awww.wd. org/ 2001/ AMLE chema-instance™
wrlns="http: S www. 1bm. com'mdmsschema® ¥=i:schemalocation="kttp:/ Swww. ibm. com/mdm’schema MOMCommon. xad™>
<RecquestControls>
<requestID-10015</request IDx>
<DWLControls
<regquesterlame>cusadmin</ requesteriames
<reguesterLanguage>100</regquesterLanguage:
</DWLControls
</ RequestControl>
<TCRMTx>
<TCRMTxTyperadd3ite</ TCEMT=<Type>
<TCREMTxChject>3iteBObj</ TCRMTxOLject s
<TCREMChiect:
<ZiteBChi>
<Name>TestSitel</Name:>
<BuildingBchi>
<Hame>TestBuildingl</Hames
<RoomBlb i
<Name>TestRooml </ Tame >
<RoomTypeTypes2</RoomTypeTypes
<RoomTypeVWalues>P lantRoom</ RoomTypeWalues>
<MachinelssetBCObix
<Mame>TestMachineAsset 1</ Name:
<ZerialMuber>MA0001</SeriallNunber:
<Description>Test Machine Nunber 1</Description:
<Owner>911111111</ Cuner>
</MachinelssetBCbi>
<MachinelssetBCOhi>
<MName>TestMachineAsset </ Hames
<ZerialMuber>MAO00Z </ SerialNumbers
<Description>Test Machine Number 2Z</Descriptions
<Owner>911111111</ Owners>
</MachineissetBCh]i>
</RoomwBCh i
</BuildingEChis
</8iteBchi>
</TCRMChjecTs
</ TCRMTx>
</ TCEM3ervice:

e  Again in the Package Explorer view, open the context menu on
SampleTransactions -> xml -> createTestSite.xml and select Run as -> MDM
Transaction

[ Package Explorer &3 . [ Data Source Explorer Eh- T
» 72 FactoryAssetTracking

, & FactoryAssetTracking.cba

> = MDMSharedResources

4 1 SampleTransactions

PR
X] addPersonxml
[] createTestSitexml
|¥] getPersonaxml New 4
Open ;3
Open With v
Show In AltShift~W
& Copy Ctrl+C
5 Copy Qualified Name
[& Paste Ctrl+V
# Delete Delete
Build Path v
Refactor Alt+ShiftT
£y Import...
5y Export..
& Refresh F5
Assign Working Sets..
Validate
Software Analyzer v
Run As y| % 1l
Debug As o 2 MDM Transaction -]
Profile As v | 3Run on MobleBrowser Simulator
»
Team Run Configurations...

Compare With o)

e In the Edit Configuration dialog, open the Server tab, enable the Use specific
server option and select the target WebSphere Application Server.
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e Click Run to execute the transaction

(=) Edit Configuration =
Edit configuration and launch. 0

Run a Master Data Management Transaction

Name: createTestSite s
%Iransactl <h Refresh E Envirenment| = Common

<-q- Use specific server: | WebSphere Application Server v8.5 at localhost >

() Use provided server details:

127001

(@ Use default port

m

Use port: | 2809

Override default server properties

Enable security

Save password
Apply Revert
@ Con D o]

e  Progress is displayed in the Console view as shown below. Wait for the Info:
Connection successful message to be displayed.

Tip: The first time you run the transaction launcher, it may take longer to complete as
client code is loaded and cached. Subsequent transactions will run faster.

[l Problems [ ] Tasks | = Properties | 414 Servers |5 Progress | = SQL Results | & Console 52 4" Search

<terminated> getPerson.xml [Master Data Management Transaction] C:\Program Files\ibm\SDP\jdk\bin'\javaw.exe (7 Jun 2013 08:30:11)
INFO: Client code attempting to load security configuration

Jun 07, 2013 S:30:12 AM com.ibm.ISecuritylLocallbhjectBaseLl3Impl. SecuritylonnectionInterceptor
ATIDIT: security.Loads3CI

Jun 07, 2013 S:30:12 AM com.ibm. ISecurityUtilityImpl.ServiceInit

AUDIT: security.GettingContic

Jun 07, 2013 S:30:12 AM com.ibmw.ws.=s2l.config. 33LConfig

WARNING: ssl.default.password.in.use.CWPEIOOL1W

Jun 07, 2013 S:30:12 AWM com.ibm.ws.ssl.config.33LConfiglanager

INFO: s=sl.disable.url.hostname.verification. CWPKIOOZTI

Jun 07, 2013 S:30:12 AM com. ibt. ISecurityUcilityImpl.ServiceInit

AUDIT: security.luthTarget

Jun 07, 2013 S:30:13 AM com.ibm. ISecurityLocallbhjectBaselLl3Impl.C83TC0lientRT

ATIDIT: security.ClienccCiI

Jun 07, 2013 &:30:13 AM com.ibmw.ws.security.config.Securitydbijectlocator

INFO: Client code attempting to load security configuration

Info: Connection successiul

Tip: The results of the transaction execution are captured in a file alongside the
original request XML file. The file is created on disk and the workspace must be
refreshed to detect and show this file.

e  Open the context menu on the SampleTransactions project and select Refresh
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[# Package Explorer 23 [ Data Source Explorer ==
» $ FactoryAssetTracking
» i= FactoryAssetTracking.cba
» =% MDMSharedResources

4 |[= SampleTrar
4 (= Mew r
% add GolInto
[X] crea
) getp Open in New Window
Show In Alt+Shift+W »
2 Copy Cirl+C
E%  Copy Qualified Name
[ Paste Ctrl+V
¥  Delete Delete
Build Path 3
Refactor Alt+5hift+T »
g Import,
e Export
< S Refresh £ >
e
=TT
Close Unrelated Projects

e Once the project is refreshed, the XML response file will be visible in a response
folder. Open the reponsecreateTestSuite.xml file to see the results.

4 = SampleTransactions
4 = xml

[ z
¥ createTestSitexml
|X] getPersonxml

If the code is working correctly then the response file will contain a SUCCESS result
code as shown below. In addition, various fields will be populated with data derived
from the server (eg the primary key of the new Site Entity Type)

<?uml wersion="1.0" encoding="UTF-3"2:>
<TCREMService xmlns="http:  wvww. ibm. com/mdm/schema™ xmlns:xsi="http:  Svww. w3, org/ 2001/ AMLEchema—ins tance™

<Responsefontrols
<ResultCod @ FesultCodes
<derviceTime erviceTimesr

<DWLControl:>
<requesterName>mdmadmin</ requesterilame>
<regquesterLanguage>100</ requesterLanguage>
<regquesterLocaleren</requesterLocales
<userRolesrmdm admin</userBoles
<requestID>10015</requestIDs>
</DWLControls
</ResponseControls>
<TxResponse>
<RequestTyperaddSite</RequestType>
<TxResult>
<ResultCod
</ TeResults>
<ResponseChject>
<3iteBChi>
<ComponentID>1000113</ Component Th
<3itepkId-526737051262753392</3itepkids
<Name>TestSitel</Hame:>
<3itelastUpdatelate>2013-06-06 05:57:07.532</3itelastUpdatelbates
<FitelastUpdatelser>mdwadmin</3itelastUpdatelser>
<SitelastUpdateTxId>72963 7051262751820/ SitelastUpdate T Idx
gl = ey
<3tatusr0</3tatuss>
</ DULStatus:
<EuildingBohi>
<ComponentID>1000129</ Component IDx
<EuildingpkId=529637051262753385</BuildingpkIds
<MName>TestBui ldingl</ Name:

FesultCodex
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Sitepkld — Primary key field allocated by MDM Server for the new Site instance.
This value can be passed to a subsequent getSite transaction to retrieve the Site
instance again.

SiteLastUpdateDate — The date and time of the last update operation (in this case the
add operation). This field must be passed to a subsequent updateSite operation to
ensure integrity between a getSite and subsequent updateSite. If in independent
update occurs between the two transactions then the update will fail as the last update
date would no longer be valid.

SiteLastUpdateUser — The user who performed the last update operation

SiteLastUpdateTxID — The transaction id of the last update operation

Q?‘ Test 2 - Creating a new Person Instance With Extended Fields

Next we will test the extended attributes defined by the XPerson Entity Type
Extension. The additional field defined by XPerson is ‘HeavyMachineryCertified’
and it applies to instances of Person.

When we invoke an add or an update transaction for Person we include this new field
in the request. Since the new field is not part of the underlying Person schema, we
include this in an “extended” portion of the request document that all requests
support.

The transaction document addPersonWithExtendedField.xml shows how this is
done:

<TCRMService xmlns:xsi="kittp:/ www.wd.org/ 2001/ XML chema-instance™
wmlns="kttp: /S vww. ibm, com/mdn/schema® xsi:schemalocation="kttp:  Swww. ibm. com/modm/schema MDMDomains. xsd™s
<RegquestControls
<reguestID>10015</regquescIDs
<DWLControls
<regquesterName>cusadmin</requesteriams:
<requesterlLanguage>100</ requesterLanguages
</DULControls
</RequestControls>
<TCRMTx®>
<TCRMTx TyperaddPerson<,/ TCRMTx Types
<TCRMTxOkhject>TCRMPersonBOh</ TCRMTHOhjects
<TCREMChject:>
<TCREMPer=sonBlh >

<Birthlate>1985-06-023</BirthDaces

<TCEMExtension>
<ExtendedChiject>EXPersonBObjExt</ExtendedChjects>
<XPersonBObjExt>

<HeavyMachineryCertifiedstrue</HeavylachineryCertifieds>
</EPersonBobiExts

</ TCEMExtension:

ZTCENPerconlizmeBOb =
<NameUsageType:1</NameUsage Type >
<GivenlameOne>James</ GiventameOnes
<LastMame>Smith</ Lastiame:

</ TCRMPersonMameEBCh >

</ TCRMPerzonECh >
</ TCRMCh ject>
</ TCRMTx >
</ TCEM3ervices
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The extended information is stored in the TCRMExtension block (supported by all
business objects). We specify the extension object that being provided in the

ExtendedObject field and then provide the extension object itself — in this case this
XPersonBObjExt.

Invoke this transaction on the server and check the results as before. You should
see a successful invocation of addPerson with populated field values and the

TXRMExtension block:

< ?xml versh0n="1.0" encoding="UTF-§"2>
<TCEMIervice xmlns="kttp: Swww. ibm. com/mdmsschema™ xmlns:xsi="http:/ Swww. w3, org/ 2001/ XML chema-instance™

<ResponseControl>

<ResultCode>3UCCESS</ResultCodes

<ZerviceTimer93</ 3erviceTimesr

<DWLControls>
<requesteriamemdmadmin/ requesterilame
<requesterlLanguage>100</requesterLanguage:
<requesterlLocalerend/requesterlocales
<userRole>mdm_admin</userkoles
<requestID>10015</requestIDs

</DWLControls

</ResponseControls
<TxResponzse>

<RequestTyperaddPerson</ RequestTypes
<TxResult:
<ResultCode>3UCCESS</ResultCodes
</ TuResults>
<ResponseCbject>
<TCREMPersonBEOk >
<PartyId>308737061232310362 </ PartyIds
<Displaylames>James Swith</Displaylame:
<PartyTypes>P</PartyTypes>
<Createdbate>2013-06-07 09:38:43.086</Createdbate>

<PartylLastUpdatebate>2013-06-07 09:35:43.102</PartyLastUpdatelates

<PartylLastUpdateUser>mdwadming/ PartyLastUpdatelsers>

<PartyLastUpdateTx Id>2093370612323087658</PartyLastUpdate T Id>

<PersonFPartyId>308737061232310362 </ PersonPartyIds
<BirthDate>1985-06-02 00:00:00.0</Birthhatex
<PartyictiveIndicator>Y</Partyictivelndicators>

<PersonlLastUpdatelate>Z013-06-07 09:38:43.102</PersonlastlUpdatelates

<PersonLastUpdatelser>mdmadmin</FersonlastUpdatelsers>

<PersonlastUpdateTxId=>209337061232308768</ PersonlastUpdate T Idx

<TCRMExtension:
<Extendedthiject>XPersonBChjExt</Extendedibjects
<HPersonBOhiExt>

</ ZPersonBChjExt>
</ TCRMExtension:

<HeavyMachineryCertifiedsrtrue</HeavyMachineryCertifieds

& Test 3 - Checking the Behaviour Extension logic is working

The file addPersonNotSixteenYet.xml contains an addPerson request for
someone who is not yet sixteen years old. Try running this transaction and ensure

the request is rejected with the following error response:
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<?xml wversion="i.0" encoding="UTF-5"7>

<TCREMService xmlns="http:/ www. ibm. com/mdm/schema™ xmlns:®ai="hitp: Swww. w3, org/ 2001/ XMLS chema—1

<HesponseContro,
<ResultCo @ esultCodex
<ferviceTime™ ServiceTimex
<DWULControls
<requesterilame>mdmadmine requesterilame >
<requesterlanguage>100</requester Language>
<requesterlocaleren</requesterLocales
“userkoleswdm admind/ userioles
<requestID>10015</regquest ID:
</ DWLConTrols
</ResponseControl>
<TxHResponse>
<Reguest TyperaddPerson</Fequest Type:>
<TxResult>
<ResultCode>FATAL</ResultCode>
<DWLError>
<Component Type>1000c

<ErrorMesssa ew Person entity wust be over 16 year@nessage)

<ErrorType>FVERET T
<LanguageCode>100</ LanguageCode>
<ReasonCods>1000110</ ReasonCode:
<Severity>0</Severity>
<Throwable>com.dwl.tcrm.exception. TCRMExtensionException:
</DWLError:>
</ TxResults
</ TxResponse:
</ TCRMService:|

Test 4 - Try some other transactions yourself

com.dwl.base.exception

e Try creating your own transaction requests using the templates under

actoryAssetTracking/resources/sampleRequest/

4 7 FactoryAssetTracking
b B st
> mh JRE System Library [WebSphere Application Server V8.5 JRE]
> =i Plug-in Dependencies
= build
> (= BundleContent
4 [ resources
4 {= sampleRequest
» [ response
FactoryAssetTracking_addBuilding_SampleAddRecordRequestxml
FactoryAssetTracking_addMachineAsset_SampleAddRecordRequest.xml
FactoryAssetTracking_addRoom_SampleAddRecordRequest.xml
FactoryAssetTracking_addSite_SampleAddRecordRequest.xml
FactoryAssetTracking_getAllBuildingBySite_SampleGetRecordRequestxml
FactoryAssetTracking_getAllMachineAssetByRoom_SampleGetRecerdRequest.xm
FactoryAssetTracking_getAllRoomByBuilding_SampleGetRecordRequest.xml
FactoryAssetTracking_getBuilding_SampleGetRecordRequestxml
FactoryAssetTracking_getMachineAsset_SampleGetRecordRequestaml
FactoryAssetTracking_getRoom_SampleGetRecordRequestaml
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